User Registration

Thank you for purchasing YOKOGAWA products.

We invite you to register your products in order to receive the most up to date product information. To register, visit the following URL, or click the “Product Registration” button in the opening screen of the Manual CD-ROM.

http://www.yokogawa.com/ns/reg/
# Contents

Checking the Contents of the Package ....................................................................................................................... 5  
Function Introduction ................................................................................................................................................... 9  
  Overview of the MX100 ......................................................................................................................................... 9  
  Flow of Operation during Installation .................................................................................................................. 10  
  Function of the Modules ....................................................................................................................................... 11  
  Functions of the MX100 Standard Software ......................................................................................................... 14  
Signal Wiring of the MX100 ........................................................................................................................................ 15  
  Attachment Position and Channel Numbers of the Input/Output Module ............................................................ 15  
  Terminal Arrangement Markings on the Terminal Cover ....................................................................................... 15  
  Wiring the Universal Input Module and DCV/TC/DI Input Module .................................................................... 16  
  Wiring the Four-Wire RTD Resistance Input Modules ........................................................................................ 16  
  Wiring the Strain Input Modules ............................................................................................................................ 17  
  Wiring the Digital Input Modules (-D05, -D24) .................................................................................................... 21  
  Wiring the Analog Output Modules ....................................................................................................................... 22  
  Wiring the PWM Output Modules ......................................................................................................................... 22  
  Wiring the Digital Output Module ....................................................................................................................... 23  
Connection to the Network ........................................................................................................................................ 24  
  Connecting the Ethernet Cable to the Main Module ............................................................................................. 24  
  Checking the Communication Status ................................................................................................................... 24  
  Connection to the PC ......................................................................................................................................... 24  
Setup Procedures of the MX100 Standard Software .................................................................................................. 25  
  Installing the MX100 Standard Software ............................................................................................................ 25  
  Installation Result .............................................................................................................................................. 25  
Operations of the MX100 Standard Software .......................................................................................................... 26  
  Connecting to or Disconnecting from the MX100 ................................................................................................. 26  
  Setting the Acquisition Conditions of the Measured Data .................................................................................. 30  
  Setting Measurement Conditions ...................................................................................................................... 32  
  Monitoring the Measured Data and Setting the Display ................................................................................... 35  
  Pausing the Updating of the Monitor Display and Reading Measured Values Using Cursors ......................... 40  
  Recording the Measured Data ............................................................................................................................ 41  
  Setting Alarms ................................................................................................................................................... 42  
  Digital Output .................................................................................................................................................... 44  
  Setting the Computation ................................................................................................................................... 46  
  Saving/Loading and Printing of Setup Data (Project) .......................................................................................... 46  
  Displaying Recorded Measured Data, Reading Values Using Cursors, and Statistical Computation over an Area 48  
  Printing the Displayed Data .............................................................................................................................. 53  
  Converting the Format of the Recorded Measured Data ...................................................................................... 53
Thank you for purchasing the MX100 Data Acquisition Unit. This manual concisely describes the handling procedures of the MX100 Data Acquisition Unit (hereinafter the “MX100”) and basic operations on the MX100 Standard Software. To ensure correct use, please read this manual thoroughly before beginning operation. The five manuals below relating to the MX100 are provided in addition to this one. Read them along with this manual. Note that the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E), this manual (IM MX100-02E), and the MX100 Standard Software User’s Manual (IM MX180-01E) are all available on the MX100 Manual CD-ROM.

<table>
<thead>
<tr>
<th>Manual Title</th>
<th>Manual No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MX100 Data Acquisition Unit User’s Manual</td>
<td>IM MX100-01E</td>
<td>Describes the functions, installation, wiring procedures, handling precautions, and other information about the MX100.</td>
</tr>
<tr>
<td>Precautions on the Use of the MX100/MW100 Data Acquisition Unit</td>
<td>IM MX100-71E</td>
<td>Summarizes the usage precautions of the MX100/MW100.</td>
</tr>
<tr>
<td>MX100/MW100 Data Acquisition Unit Installation and Connection Guide</td>
<td>IM MX100-72E</td>
<td>Describes concisely the installation and wiring procedures of the MX100/MW100.</td>
</tr>
<tr>
<td>Control of pollution caused by MX100/MW100 products</td>
<td>IM MX100-91C</td>
<td>Describes control of pollution caused by the product.</td>
</tr>
<tr>
<td>MX100 Standard Software User’s Manual</td>
<td>IM MX180-01E</td>
<td>Describes the functions and operations of the MX100 Standard Software that comes standard with the MX100 main module.</td>
</tr>
</tbody>
</table>

Notes

- When configuring an MX100 system, the versions of the instruments used in the system indicated by the hardware style number and software release number must meet the following conditions.
  - The main module style number must be greater than or equal to the style numbers of any input/output modules.
  - The PC software release number must be greater than or equal to the style number of the main module.
- Certain functions may become disabled on instruments or software that do not meet these conditions, or the system may not be able to be built.
- This manual describes the MX100 style number “S3,” and release number R3.03 of the MX100 Standard Software. Check the style number on the name plate (see page 5 for the location of the name plate).
- Every effort has been made in the preparation of this manual to ensure the accuracy of its contents. However, should you have any questions or find any errors, please contact YOKOGAWA dealer.
- This operation guide does not cover the handling and operating procedures of Windows.
- Copying or reproducing all or any part of the contents of this manual without YOKOGAWA’s permission is strictly prohibited.
- The TCP/IP software of this product and the document concerning the TCP/IP software have been developed/created by YOKOGAWA based on the BSD Networking Software, Release 1 that has been licensed from California University.

Trademarks

- DAQMMASTER is a registered trademark of Yokogawa Electric Corporation.
- Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
- Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems Incorporated.
- Company and product names that appear in this manual are registered trademarks or trademarks of their respective holders.
- The company and product names used in this manual are not accompanied by the registered trademark or trademark symbols (® and ™).

Revisions

1st Edition: May, 2003  
2nd Edition: November, 2004  
3rd Edition: June, 2006  
Checking the Contents of the Package

Unpack the box and check the contents before operating the instrument. If some of the contents are not correct, or if any items are missing or damaged, contact the dealer from whom you purchased them.

Checking the Model and Suffix Code

Check the model and suffix code on the name plate indicated in the figure below.

Note

When contacting the dealer from which you purchased the instrument, please give them the NO. (instrument number) on the name plate.

Main Module

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MX100</td>
<td></td>
<td>MX100 main module (comes with MX100 Standard Software)</td>
</tr>
<tr>
<td>Language</td>
<td>-E</td>
<td>English</td>
</tr>
<tr>
<td>Supply voltage</td>
<td>-1</td>
<td>100 VAC-240 VAC</td>
</tr>
<tr>
<td>Power supply and power cord</td>
<td>D</td>
<td>3-pin inlet, UL/CSA Standard power cord</td>
</tr>
<tr>
<td></td>
<td>F</td>
<td>3-pin inlet, VDE Standard power cord</td>
</tr>
<tr>
<td></td>
<td>R</td>
<td>3-pin inlet, AS Standard power cord</td>
</tr>
<tr>
<td></td>
<td>Q</td>
<td>3-pin inlet, BS Standard power cord</td>
</tr>
<tr>
<td></td>
<td>H</td>
<td>3-pin inlet, GB Standard power cord (complies with CCC)</td>
</tr>
<tr>
<td></td>
<td>W</td>
<td>Screw terminal (does not come with a power cord)</td>
</tr>
<tr>
<td>Options</td>
<td>/DS</td>
<td>Dual Save function</td>
</tr>
<tr>
<td></td>
<td>/SL1*</td>
<td>10-CH Quick Start Package</td>
</tr>
<tr>
<td></td>
<td>/SL2*</td>
<td>20-CH Quick Start Package</td>
</tr>
<tr>
<td></td>
<td>/SL3*</td>
<td>30-CH Quick Start Package</td>
</tr>
</tbody>
</table>

* These can not be selected together. Shipped with the MX110-UNV-M10 and MX150 installed.
### Universal Input Module, DCV/TC/DI Input Module, and Four-Wire RTD Resistance Input Module

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MX110</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-UNV</td>
<td>For DCV/TC/DI/3-wire RTD input</td>
<td></td>
</tr>
<tr>
<td>-VTD</td>
<td>For DCV/TC/DI input</td>
<td></td>
</tr>
<tr>
<td>-V4R</td>
<td>For DCV/TC/DI/4-wire RTD/4-wire resistance input</td>
<td></td>
</tr>
<tr>
<td>Number of channels and measurement interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-H04</td>
<td>4-CH, high-speed measurement</td>
<td></td>
</tr>
<tr>
<td>-M06</td>
<td>6-CH, medium-speed measurement</td>
<td></td>
</tr>
<tr>
<td>-M10</td>
<td>10-CH, medium-speed measurement</td>
<td></td>
</tr>
<tr>
<td>-L30</td>
<td>30-CH, medium-speed measurement</td>
<td></td>
</tr>
<tr>
<td>Options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>/NC</td>
<td>Without the plate with the clamp terminals</td>
<td></td>
</tr>
<tr>
<td>/H3</td>
<td>M3 screw terminals</td>
<td></td>
</tr>
</tbody>
</table>

*1 –H04 or –M10 must be selected if –UNV is selected. –M06 must be selected if –V4R is selected. -VTD must be selected if –L30 is selected.

*2 /NC can only be selected if –M10 is selected.

*3 /H3 can only be selected if –L30 is selected.

### Strain Input Module

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MX112</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-B12</td>
<td>Internal bridge resistance: 120 Ω</td>
<td></td>
</tr>
<tr>
<td>-B35</td>
<td>Internal bridge resistance: 350 Ω</td>
<td></td>
</tr>
<tr>
<td>-NDI</td>
<td>NDIS connector for connections to an external bridge head</td>
<td></td>
</tr>
<tr>
<td>Number of channels and measurement interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-M04</td>
<td>4-CH, medium-speed measurement</td>
<td></td>
</tr>
</tbody>
</table>

### Digital Input Module

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MX115</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-D05</td>
<td>Non-voltage contact, 5-V logic, open collector input</td>
<td></td>
</tr>
<tr>
<td>-D24</td>
<td>24 V logic</td>
<td></td>
</tr>
<tr>
<td>Number of channels and measurement interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-H10</td>
<td>10-CH, high-speed measurement</td>
<td></td>
</tr>
<tr>
<td>Options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>/NC</td>
<td>Without the plate with the clamp terminals</td>
<td></td>
</tr>
</tbody>
</table>

### Analog Output Module

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MX120</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-VAO</td>
<td>Voltage/current output</td>
<td></td>
</tr>
<tr>
<td>-PWM</td>
<td>Pulse width modulation output</td>
<td></td>
</tr>
<tr>
<td>Number of channels and output update interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-M08</td>
<td>8-CH, minimum output update interval: 100 ms</td>
<td></td>
</tr>
</tbody>
</table>

### Digital Output Module

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MX125</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-MKC</td>
<td>A contact output</td>
<td></td>
</tr>
<tr>
<td>Number of channels and output update interval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-M10</td>
<td>10-CH, minimum output update interval: 100 ms</td>
<td></td>
</tr>
</tbody>
</table>

### Base Plate

<table>
<thead>
<tr>
<th>Model</th>
<th>Suffix Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MX150</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Base type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-1 to -6*</td>
<td>The value of the suffix code corresponds to the maximum number of input/output modules that can be installed. MX150-6 is for one main module, and six input/output modules.</td>
<td></td>
</tr>
</tbody>
</table>

* One unit of the MX110-VTD-L30 requires three input/output modules’ worth of space when installing.
Checking the Contents of the Package

Standard Accessories

The following standard accessories are supplied with the main module. Check that all contents are present and that they are undamaged.

Power Cord (one of the following power cords is supplied according to the instrument’s suffix codes)*1

UL/CSA Standard
A1074WD

VDE Standard
A1009WD

AS Standard
A1024WD

BS Standard
A1054WD

GB Standard
(complies with CCC)
A1064WD

*1 Not included when screw terminals are specified for the power section (Suffix code: W).

MX100 Standard Software
Model: MX180

MX100 Manual CD-ROM*2
Part number: B8722XH

*2 • MX100 Data Acquisition Unit User’s Manual (IM MX100-01E)
• MX100 Data Acquisition Unit Operation Guide (This manual) (IM MX100-02E)
• Contains the MX100 Standard Software User’s Manual (IM MX180-01E).

Paper Manuals

• MX100 Data Acquisition Unit Operation Guide (This manual) (IM MX100-02E)
• Precautions on the Use of the MX100/MW100 (IM MX100-71E)
• MX100/MW100 Data Acquisition Unit Installation and Connection Guide (IM MX100-72E)
• Control of pollution caused by MX100/MW100 products (IM MX100-91C)

Optional Accessories (Sold Separately)

Terminals

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Model</th>
<th>Min. Q’ty</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10-CH screw terminal block (with RJC)</td>
<td>772061</td>
<td>1</td>
<td>Dedicated to the MX110-UNV-M10/MX110-D05-H10/MX115-D24-H10</td>
</tr>
<tr>
<td>2</td>
<td>Connection cable between the input module and screw terminal block</td>
<td>772062-050</td>
<td>1</td>
<td>Cable length: 50 cm*1</td>
</tr>
<tr>
<td>3</td>
<td>Connection cable between the input module and screw terminal block</td>
<td>772062-100</td>
<td>1</td>
<td>Cable length: 100 cm*1</td>
</tr>
<tr>
<td>4</td>
<td>Plate with clamp terminals (with RJC)</td>
<td>772063</td>
<td>1</td>
<td>Dedicated to the MX110-UNV-M10/MX115-D05-H10/MX115-D24-H10</td>
</tr>
<tr>
<td>5</td>
<td>Clamp terminal</td>
<td>772064</td>
<td>1</td>
<td>Dedicated to the MX110-UNV-H04</td>
</tr>
<tr>
<td>6</td>
<td>Clamp terminal</td>
<td>772065</td>
<td>1</td>
<td>Dedicated to the MX120-VAO-M08/MX120-PWM-M08/MX125-MKC-M10</td>
</tr>
<tr>
<td>7</td>
<td>Connector cover</td>
<td>772066</td>
<td>1</td>
<td>For empty slots with no module installed</td>
</tr>
<tr>
<td>8</td>
<td>Plate with clamp terminals</td>
<td>772067</td>
<td>1</td>
<td>Dedicated to the MX110-V4R-M06</td>
</tr>
<tr>
<td>9</td>
<td>Plate with clamp terminals (Built in bridge: 120 Ω)</td>
<td>772068</td>
<td>1</td>
<td>Dedicated to the MX112-B12-M04*2</td>
</tr>
<tr>
<td>10</td>
<td>Plate with clamp terminals (Built in bridge: 350 Ω)</td>
<td>772069</td>
<td>1</td>
<td>Dedicated to the MX112-B35-M04*2</td>
</tr>
<tr>
<td>11</td>
<td>Plate with screw terminals (M3 screw, with RJC)</td>
<td>772080</td>
<td>1</td>
<td>Dedicated to the MX110-UNV-M10, MX115-D05-H10, and MX115-D24-H10</td>
</tr>
<tr>
<td>12</td>
<td>Plate with clamp terminals for current (Built in shunt resistor 10 Ω)</td>
<td>772081</td>
<td>1</td>
<td>Dedicated to the MX110-UNV-M10</td>
</tr>
<tr>
<td>13</td>
<td>Plate with clamp terminals for current (Built in shunt resistor 100 Ω)</td>
<td>772082</td>
<td>1</td>
<td>Dedicated to the MX110-UNV-M10</td>
</tr>
<tr>
<td>14</td>
<td>Plate with clamp terminals for current (Built in shunt resistor 250 Ω)</td>
<td>772083</td>
<td>1</td>
<td>Dedicated to the MX110-UNV-M10</td>
</tr>
</tbody>
</table>

*1 772062 is only applicable between the MX110-UNV-M10 and the screw terminal block (772061), the MX115-D05-H10 and the screw terminal block (772061), and the MX115-D24-H10 and the screw terminal block (772061).

*2 772068 is only applicable to MX112-B35-M04. 772069 is only applicable to MX112-B12-M04.
### Shunt Resistors

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Model</th>
<th>Min. Q’ty</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>Shunt resistor (for the clamp terminal)</td>
<td>438920</td>
<td>1</td>
<td>Resistance: 250 Ω ±0.1%</td>
</tr>
<tr>
<td>16</td>
<td>Shunt resistor (for the clamp terminal)</td>
<td>438921</td>
<td>1</td>
<td>Resistance: 100 Ω ±0.1%</td>
</tr>
<tr>
<td>17</td>
<td>Shunt resistor (for the clamp terminal)</td>
<td>438922</td>
<td>1</td>
<td>Resistance: 10 Ω ±0.1%</td>
</tr>
<tr>
<td>18</td>
<td>Shunt resistor</td>
<td>415920</td>
<td>1</td>
<td>Resistance: 250 Ω ±0.1%</td>
</tr>
<tr>
<td>19</td>
<td>Shunt resistor</td>
<td>415921</td>
<td>1</td>
<td>Resistance: 100 Ω ±0.1%</td>
</tr>
<tr>
<td>20</td>
<td>Shunt resistor</td>
<td>415922</td>
<td>1</td>
<td>Resistance: 10 Ω ±0.1%</td>
</tr>
</tbody>
</table>

### Memory cards

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Model</th>
<th>Min. Q’ty</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>Adapter for compact flash card</td>
<td>772090</td>
<td>1</td>
<td>Adapter for inserting into PC card slot</td>
</tr>
<tr>
<td>22</td>
<td>Compact Flash card*</td>
<td>772093</td>
<td>1</td>
<td>512 MB</td>
</tr>
<tr>
<td>23</td>
<td>Compact Flash card*</td>
<td>772094</td>
<td>1</td>
<td>1 GB</td>
</tr>
<tr>
<td>24</td>
<td>Compact Flash card*</td>
<td>772095</td>
<td>1</td>
<td>2 GB</td>
</tr>
</tbody>
</table>

* Operating temperature range: –40 to 85°C

### Application Software (Sold Separately)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Model</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>MXLOGGER WX103</td>
<td></td>
<td>Data acquisition software for the MX100.</td>
</tr>
<tr>
<td>2</td>
<td>GateMX/MW WX1</td>
<td></td>
<td>MX100/MW100 Gate software for connecting to DAQLOGGER data acquisition software.</td>
</tr>
</tbody>
</table>

### API (Sold Separately)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Model</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>API for the MX100/DARWIN MX190</td>
<td></td>
<td>Provides an API and extended API for the MX100 and DARWIN.</td>
</tr>
</tbody>
</table>

### MX100 Style Upgrade Kit* (Sold separately)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Model</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>MX100 Style Upgrade Kit</td>
<td>772050-01</td>
<td>Updates the old style of the MX100 main module to the latest style.</td>
</tr>
<tr>
<td>2</td>
<td>MX100 Style Upgrade Kit (with the /DS option)</td>
<td>772050-03</td>
<td>Updates the old style of the MX100 main module with the Dual Save function (/DS option) to the latest style.</td>
</tr>
</tbody>
</table>

* Cannot be used with the special specification MX100 main module.
Function Introduction

For further details on each function, see the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E) and the MX100 Standard Software User’s Manual (IM MX180-01E) provided on the accompanying CD-ROM.

Overview of the MX100

The MX100 consists of the main module equipped with an Ethernet port, input/output modules that perform input or output of signals, and the base plate that attaches and connects all of these. The main module and the PC is connected locally via the Ethernet interface in a one-to-one relationship. By installing the MX100 Standard Software into the PC, you can use the PC to configure the acquisition conditions of the measured data of the MX100 and monitor or retrieve the measured data. The MX100 Standard Software allows a single PC to connect to a single MX100 unit (up to 60 channels in terms of the number of input channels). MXLOGGER, a software program sold separately, allows one to 20 PCs to connect to a single MX100 unit (up to 1200 channels in terms of the number of input channels).

One-to-one connection

- MX100 Standard Software
- MXLOGGER (sold separately)
- Software created using the API for the MX100/DARWIN (sold separately)

One-to-N connection

- MXLOGGER (sold separately)
- Software created using the API for the MX100/DARWIN (sold separately)
Flow of Operation during Installation

The figure below shows the general flow of operation when the MX100 is installed initially.

Operations on the MX100
- **Install the MX100**
- **Wire the input/output modules**
- **Connect the network cable**
- **Connect the power cable**
- **Turn ON the power switch**

Operations on the PC
- **Set up the MX100 Standard Software**
- **Connect to the network**
- **Set the network parameters of the PC**
- **Start the Integration Monitor**
- **Set the network parameters of the MX100**
- **Connect the MX100**
- **Set the acquisition conditions**
- **Set the measurement conditions**
- **Monitor the measured data**
- **Change the display conditions**
- **Record the measured data**
- **Start the Viewer**
- **Display the recorded data**

**Pages 24 to 29**
- Set the monitor/record interval, record start/stop conditions, etc.
- Set the input mode, measurement range, measurement span, etc.

**Pages 30 and 31**
- Set the acquisition/conditions
- Set the measurement conditions

**Pages 32 to 34**
- Monitor the measured data
- Change the display conditions

**Pages 35 and 36**
- Record the measured data

**Page 41**
- Start the Viewer

**Page 48 to 53**
- Display the recorded data

* MX100/MW100 Data Acquisition Unit Installation and Connection Guide (IM MX100-72E)
Function of the Modules

Main Module
The main module is equipped with a power supply connector, a power switch, an Ethernet port, a CF card slot, a 7-segment LED, dipswitches and other parts. It contains functions such as the power supply to and the control of each input/output module, communications with a PC, data storage to the CF card when communication is disconnected.

**Ethernet port**
- **Power switch**
- **CF card slot**
- **Power connector or screw terminal**
- **7-segment LED**
- **Dipswitch**

*Normally, turn all switches ON. Used to enable the /DS option functions, initialize settings, and perform other functions.*

---

Input/Output Modules
The following twelve types of modules are available.

- **4-CH, High-Speed Universal Input Module (MX110-UNV-H04)**
  - Minimum measurement interval: 10 ms
  - Maximum number of inputs: 4 inputs
  - Input types: DC voltage, TC, 3-wire RTD, and DI (LEVEL, non-voltage contact)

- **10-CH, Medium-Speed Universal Input Module (MX110-UNV-M10)**
  - Minimum measurement interval: 100 ms
  - Maximum number of inputs: 10 inputs
  - Input types: DC voltage, TC, 3-wire RTD, and DI (LEVEL, non-voltage contact)

- **30-CH, Medium-Speed DCV/TC/DI Input Module (MX110-VTD-L30)**
  - Minimum measurement interval: 500 ms
  - Maximum number of inputs: 30 inputs
  - Input types: DC voltage, TC, and DI (LEVEL, non-voltage contact)

For MX110-VTD-L30

For MX110-VTD-L30/H3
Function Introduction

- 6-CH, Medium-Speed 4-Wire RTD Resistance Input Module (MX110-V4R-M06)
  - Minimum measurement interval: 100 ms
  - Maximum number of inputs: 6 inputs
  - Input types: DC voltage, 4-wire RTD, 4-wire resistance, and DI (LEVEL, non-voltage contact)

- 4-CH, Medium-Speed Strain Input Module (MX112-B12-M04, MX112-B35-M04)
  - Minimum measurement interval: 100 ms
  - Maximum number of inputs: 4 inputs
  - Input system: floating balanced input (isolation between channels)

- 4-CH, Medium-Speed Strain Input Module (MX112-NDI-M04)
  - Minimum measurement interval: 100 ms
  - Maximum number of inputs: 4 inputs
  - Input system: floating balanced input (non-isolation between channels)

- 10-CH, High-Speed Digital Input Module (MX115-D05-H10)
  - Minimum measurement interval: 10 ms
  - Maximum number of inputs: 10 inputs
  - Input types: DI (non-voltage contact, open collector, 5-V logic)

- 10-CH, High-Speed Digital Input Module (MX115-D24-H10)
  - Minimum measurement interval: 10 ms
  - Maximum number of inputs: 10 inputs
  - Input types: DI (24-V logic)

The 10-CH, Pulse Input Module (MX114-PSL-M10) cannot be used with the MX100. For details see “Input/Output Modules” in section 1.1 of the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).
• 8-CH, Medium-Speed Analog Output Module (MX120-VAO-M08)
  - Output update interval: 100 ms (shortest)
  - Maximum number of outputs: 8 outputs
  - Output type: DC voltage, DC current

• 8-CH, Medium-Speed PWM Output Module (MX120-PWM-M08)
  - Output update interval: 100 ms (shortest)
  - Maximum number of outputs: 8 outputs
  - Output type: PWM

• 10-CH, Medium-Speed Digital Output Module (MX125-MKC-M10)
  - Output update interval: 100 ms (shortest)
  - Maximum number of outputs: 10 outputs
  - Output type: A contact (SPST)
Functions of the MX100 Standard Software

The MX100 Standard Software consists of the three software programs below.

**Integration Monitor**
Enables you to connect or disconnect communications, configure acquisition conditions and display conditions of the measured channels, set up computations, monitor measured and computed data, save measured and computed data, and carry out other operations.

**Viewer**
Enables you to display measured and computed data that has been saved, read values and perform statistical computation over an area using cursors, and convert the measured and computed data into various file formats such as Excel.

**Calibrator**
This program is used to calibrate the input modules and output modules of the MX100. This operation guide does not cover the operating procedures of the software. See the *MX100 Standard Software User’s Manual* (IM MX180-01E).
Signal Wiring of the MX100

For a description of the installation procedure, module attachment procedure, signal wiring details, and wiring of the power supply, see the MX100/MW100 Data Acquisition Installation and Connection Guide (IM MX100-72E) or the MX100 Data Acquisition Unit User's Manual (IM MX100-01E). For the safety precautions, see the Precautions on the Use of the MX100/MW100 Data Acquisition Unit (IM MX100-71E) or the MX100 Data Acquisition Unit User's Manual (IM MX100-01E).

Attachment Position and Channel Numbers of the Input/Output Module

The figure below shows how the MX100 Standard Software identifies the channel numbers.

Representation of channel numbers:

```
<table>
<thead>
<tr>
<th>Slot number</th>
<th>Channel number in a unit (001 to 060)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Unit number (00 to 19)*1</td>
</tr>
</tbody>
</table>
```

*1 When connecting to the module using the MX100 Standard Software, the number is fixed to 00.

Terminal Arrangement Markings on the Terminal Cover

On the rear side of the terminal cover of each input/output module are characters that indicate the functions of the terminals and terminal symbols. Connect the wires according to the markings. The figure below is an example only.
Wiring the Universal Input Module and DCV/TC/DI Input Module

• Thermocouple input

- Compensation lead

• RTD input

- Lead wire resistance per wire of 10 Ω or less*. Make the resistance of the three wires equal.

- In the case of Pt100 Ω.
  5 Ω max for Pt50 Ω.
  1 Ω max. for Cu10 Ω.

• DC voltage input/DI input (contact)

- DC voltage input

- Contact

• DC current input

- Shunt resistor

- Example: For 4 to 20 mA input, shunt resistance values should be 250 Ω ±0.1%.

- A plate with clamp terminals for current with built-in shunt resistance can be attached to the 10-CH, Medium-Speed Universal Input Module.

Terminal type: Clamp, or screw (in the case of M3: -L30/H3)
Applicable wire size: For -H04: 0.2 to 2.5mm² (AWG24 to 12)
For -M10 and -L30 (clamp): 0.14 to 1.5mm² (AWG26 to 16)

Note
- On the 10-CH, Medium-Speed Universal Input module, RTD input terminals A and B are isolated on each channel. Terminal b is shorted internally across all channels.
- Measurement using RTDs cannot be performed with the 30-CH, Medium-Speed DCV/TC/DI Input Module.
- When the screw terminal plate (model 772080) is connected to the 10-CH, Medium-Speed Universal Input Module, the terminal arrangement differs from that of clamped terminals, so wire according to the markings on the terminal cover.

Wiring the Four-Wire RTD Resistance Input Modules

• DC voltage input/DI (contact) input

- Voltage

- DC voltage input

- Contact

- Nothing connected to the I or C terminal

• DC current input

- DC current input

- Shunt resistor

- Example: For 4 to 20 mA input, shunt resistance values should be 250 Ω ±0.1%.

Terminal type: Clamp
Applicable wire size: 0.14 to 1.5mm² (AWG26 to 16)
Wiring the Strain Input Modules

• One-Gauge Method

- B12, -B35

Setting switch

No.1 No.2 No.3 No.4 No.5
OFF ON ON ON OFF

- NDI

Bridge head
(701955 or 701956)

SW 1 2 3 4 5

No.1 No.2 No.3 No.4 No.5
ON ON OFF ON OFF

- B12, -B35

Setting switch

No.1 No.2 No.3 No.4 No.5
OFF ON ON ON OFF

- NDI

Bridge head
(701955 or 701956)

SW 1 2 3 4 5

No.1 No.2 No.3 No.4 No.5
OFF ON ON ON OFF

R: fixed resistance
r: resistance value of lead wire
Rg: resistance value of strain gauge
e: output voltage from bridge
E: voltage applied to bridge

R: fixed resistance
r: resistance value of lead wire
Rg: resistance value of strain gauge
e: output voltage from bridge
E: voltage applied to bridge
**Signal Wiring of the MX100**

- **Adjacent Two-Gauge Method**

  ![Diagram](image1)

  \[ R: \text{fixed resistance} \]

  \[ r: \text{resistance value of lead wire} \]

  \[ R_g: \text{resistance value of strain gauge} \]

  \[ e: \text{output voltage from bridge} \]

  \[ E: \text{voltage applied to bridge} \]

- **Opposing Two-Gauge Method**

  ![Diagram](image2)

  \[ R: \text{fixed resistance} \]

  \[ r: \text{resistance value of lead wire} \]

  \[ R_g: \text{resistance value of strain gauge} \]

  \[ e: \text{output voltage from bridge} \]

  \[ E: \text{voltage applied to bridge} \]
- **Opposing Two-Gauge Three-Wire Method**

![Signal Wiring of the MX100](image)

-B12, -B35

Cannot be connected. Use -NDI.

- **NDI**

<table>
<thead>
<tr>
<th>Setting switch</th>
<th>Bridge head</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON</td>
<td>(701955 or 701956)</td>
</tr>
<tr>
<td>OFF</td>
<td></td>
</tr>
</tbody>
</table>

Rg1

Rg2

**R**: fixed resistance

**r**: resistance value of lead wire

**Rg**: resistance value of strain gauge

**e**: output voltage from bridge

**E**: voltage applied to bridge
• Four-Gauge Method

- B12, -B35
Setting switch

- NDI
Bridge head
(701955 or 701956)
Wiring the Digital Input Modules (-D05, -D24)

**Note**

- On the digital input modules, the negative terminals and empty terminals of all channels are shorted internally.
- When the screw terminal plate (model 772080) is connected to the digital input module, the terminal arrangement differs from that of clamp terminals, therefore wire according to the markings on the terminal cover.

### Wiring with the -D05 Option

#### Contact input

- **Input type:** DI (non-voltage contact, open collector, and 5 V logic)
- **Input format:** Pull-up at approximately 5 V/approximately 5 kΩ, common electric potential between channels
- **Min. detection pulse width:** Twice the sampling interval or more
- **Input threshold level:**
  - Non-voltage contact, open collector: ON at 100 Ω or less and OFF at 100 kΩ or greater
  - 5-V logic: OFF at 1 V or less and ON at 3 V or greater
- **Contact/transistor rating:** Contact with a rating of 15 VDC or greater and 30 mA or greater
  - Vce and Ic are transistors with ratings of 15 VDC or more, and 30 mA or more, respectively.
- **Terminal type:** Clamp
- **Applicable wire size:** 0.14 to 1.5 mm² (AWG26 to 16)

#### Transistor input

- **Input type:** DI (non-voltage contact, open collector, and 5 V logic)
- **Input format:** Pull-up at approximately 5 V/approximately 5 kΩ, common electric potential between channels
- **Min. detection pulse width:** Twice the sampling interval or more
- **Input threshold level:**
  - Non-voltage contact, open collector: ON at 100 Ω or less and OFF at 100 kΩ or greater
  - 5-V logic: OFF at 1 V or less and ON at 3 V or greater
- **Contact/transistor rating:** Contact with a rating of 15 VDC or greater and 30 mA or greater
  - Vce and Ic are transistors with ratings of 15 VDC or more, and 30 mA or more, respectively.
- **Terminal type:** Clamp
- **Applicable wire size:** 0.14 to 1.5 mm² (AWG26 to 16)

#### 5V logic input

- **Input type:** DI (non-voltage contact, open collector, and 5 V logic)
- **Input format:** Pull-up at approximately 5 V/approximately 5 kΩ, common electric potential between channels
- **Min. detection pulse width:** Twice the sampling interval or more
- **Input threshold level:**
  - Non-voltage contact, open collector: ON at 100 Ω or less and OFF at 100 kΩ or greater
  - 5-V logic: OFF at 1 V or less and ON at 3 V or greater
- **Contact/transistor rating:** Contact with a rating of 15 VDC or greater and 30 mA or greater
  - Vce and Ic are transistors with ratings of 15 VDC or more, and 30 mA or more, respectively.
- **Terminal type:** Clamp
- **Applicable wire size:** 0.14 to 1.5 mm² (AWG26 to 16)

### Wiring with the -D24 Option

- **24 V logic input

#### Main Input Specifications (-D24)

- **Input type:** DI (24 V logic)
- **Input format:** Common potential between ch
- **Min. detection pulse width:** Twice the sampling interval or more
- **Input threshold level:**
  - 24 V logic: OFF at 6 V or less and ON at 16 V or greater
- **Terminal type:** Clamp
- **Applicable wire size:** 0.14 to 1.5 mm² (AWG26 to 16)
Wiring the Analog Output Modules

External power supply

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Current</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ Vext</td>
<td>Load i+</td>
</tr>
<tr>
<td>-</td>
<td>Direction of current</td>
</tr>
</tbody>
</table>

(when using current output)

**CAUTION**

Two power supply terminals are connected internally. Therefore, do not connect a separate external power supply to them as fire can result.

Main Output Specifications

- **Terminal type:** Clamp, attached and removed in units of 4 channels
- **Load impedance:** Voltage 5 kΩ or more
- **Current** 600 Ω or less
- **Applicable wire size:** 0.08 to 2.5 mm² (AWG28 to 12)

Wiring the PWM Output Modules

External power supply

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Pulse width output</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ Vext</td>
<td>Load</td>
</tr>
<tr>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

**CAUTION**

Two power supply terminals are connected internally. Therefore, do not connect a separate external power supply to them as fire can result.

Main Output Specifications

- **Output capacity:** 1A/ch max, however, 4 A or less total for all modules*1, *2
- **Terminal type:** Clamp, attached and removed in units of 4 channels
- **Applicable wire size:** 0.08 to 2.5 mm² (AWG28 to 12)

*1 A 1A current limit circuit is built in to the output circuit. Once the current limit circuit is ON, the circuit continues to operate unless the external power supply is turned OFF.

*2 This module has a built-in fuse. The built-in fuse protects against fires or abnormal emissions of heat due to load shortages or other abnormalities.
Wiring the Digital Output Module

### Main Output Specifications
- **Contact mode:** A contact (SPST)
- **Contact capacity:** 250 VDC/0.1 A, 250 VAC/2 A, or 30 VDC/2 A (resistance load)
- **Terminal type:** Clamp, attached and removed in units of 5 channels
- **Applicable wire size:** 0.08 to 2.5 mm² (AWG28 to 12)

---

**Note**

Do not connect anything to the empty terminals of the digital output module.
Connection to the Network

Connecting the Ethernet Cable to the Main Module
Connect the Ethernet cable to the Ethernet port (10BASE-T/100BASE-TX) of the main module. Use a UTP cable (category 5 or better) or an STP cable for the Ethernet cable.

Checking the Communication Status
You can check the status on the two LEDs at the upper-right and lower-right of the Ethernet port.

Connection to the PC
Make the connection via a hub. As shown in the figure below, connect the MX100 to the PC locally using a one-to-one relationship.

System requirements for the MX100 Standard Software
- **OS**
  - Windows 2000 Professional SP4,
  - Windows XP SP2 (excluding x64 Edition),
  - Windows Vista Home Premium (excluding the 64-bit Edition),
  - or Windows Vista Business (excluding the 64-bit Edition).

- **PC**
  - For Windows 2000 and Windows XP:
    - PC with an Intel Pentium II, 400 MHz or higher CPU (Pentium III, 1 GHz or higher recommended), and at least 256 MB of memory (512 MB or more recommended)
  - For Windows Vista:
    - PC with an Intel Pentium 4, 3.0 GHz or higher CPU and at least 1 GB of memory (2 GB or more recommended)

- **Hard disk**
  - Free space: 50 MB or more (1 GB or more recommended)
  - RPM: 7200 rpm or more

- **Display**
  - 1024 × 768 dot resolution or higher
  - (1280 × 1024 dots or higher recommended), 65536 colors or more
  - With Windows Vista, a video card recommended for the OS

**Note**
- The NIC on the PC should support 100BASE-TX (recommended) or 10BASE-T.
- When connected to an external network, the communications within the network other than those related to the MX100 may hinder the measurement operations on the MX100.
Setup Procedures of the MX100 Standard Software

For details on the setup procedure, see the MX100 Standard Software User’s Manual (IM MX180-01E). For the MX100 Standard Software system requirements, see “Connection to the PC” in “Connection to the Network.”

Installing the MX100 Standard Software

Insert the MX100 Standard Software Setup CD-ROM into the CD-ROM drive. The language selection screen appears. Select the language and the setup program automatically starts. If the installer does not automatically start, double-click SETUP.EXE in the DISK1 folder in the English folder on the CD-ROM. After the setup program starts, follow the instructions that appear on the screen. In the middle of the installation, a dialog box shown below opens prompting you to enter the serial number. The serial number is written on the label that is attached to the front of the case for the MX100 Standard Software Setup CD-ROM.

![User Information](image)

Installation Result

When the software program is installed properly, the folder MX100 Standard is created in the specified directory (C:\ by default). MX100 Standard is registered in the program list and MX100 Standard (referred to as the Integration Monitor in this operation guide), MX100 Viewer, and MX100 Calibration are registered under it.

![MX100 Standard](image)
Connecting to or Disconnecting from the MX100

Before carrying out the following procedure, check that the power switch on the MX100 is ON and that the PC is connected to the MX100 locally in a one-to-one relationship as shown under “Connection to the PC” in “Connection to the Network.”

When Connecting for the First Time

1. Enter the IP address and subnet mask of the PC as shown in the figure below. Set the IP address of the PC to a fixed address (192.168.1.100, for example), not dynamically. Set the subnet mask to 255.255.255.0. Leave the default gateway blank or set it to 0.0.0.0.

   The dialog box in the left figure appears on Windows 2000. To open this dialog box, choose Properties from the My Network Places short-cut menu. Then, choose Local Area Connection > Properties under the General tab > Internet Protocol (TCP/IP) > Properties. On Windows XP, open Control Panel, choose Network and Internet Connections > Network Connections > Local Area Connection Properties > Internet Protocol (TCP/IP) under the General tab > Properties.

2. Click Programs > MX100 Standard > MX100 Standard. The Integration Monitor starts.

3. Click Search. If an MX100 is found, icons appear in the frame containing the Search button for MX100s in the same network segment.

Note

- If an icon for an MX100 does not appear, see “When Connection Cannot Be Made or When Connecting to Another MX100.”
- If multiple MX100s are connected in the same network segment, all of those MX100s are detected and their icons are displayed.
4. Click the icon indicating the MX100. The network information about the MX100 appears.

5. Click **Edit Network setup** and enter the machine name and IP address. When you click **Edit Network setup**, the **Machine Name**, **IP Address**, **Subnet Mask**, and **Default Gateway** items turn in to text boxes.

   You can enter the machine name using up to 64 alphanumeric characters, but the entry is optional.

   The default value of the IP address, subnet mask, and default gateway is 0.0.0.0. A connection to the network cannot be made if the default IP address and subnet mask values are used. For example, the IP address could be changed to 192.168.1.XX (where XX is 1 to 99 or 101 to 254), and the subnet mask could be changed to 255.255.255.0. The default gateway is set to 0.0.0.0 (default value).

6. Click **Apply**.

   The network information disappears, and the machine name is displayed in the icon indicating the MX100.
7. Click the icon indicating the MX100 again. The network information about the connected MX100 appears again.

8. Click Connect.

When connected, the Monitor screen opens as shown in the figure below.

Disconnecting

1. Click Connection on the Monitor bar.
2. Click Disconnect.

Reconnecting to the Same MX100

- If the Connection screen is opened, click Connect.

- If the Integration Monitor is closed, start the Integration Monitor. The connection is made automatically when you start the Integration Monitor.

When Connection Cannot Be Made or When Connecting to Another MX100

If the MX100 that you are connecting to is already connected by another user or the connection cannot be made such as due to an incorrect designation of the IP address and you try to make a connection, the dialog box shown below remains on the screen.

If this happens, click Cancel in the dialog box, and click Search on the Connection screen. If the MX100 is in the same network segment as the PC, an icon indicating the MX100 appears in the frame containing the Search button. If the icon appears, click the icon to check the network information (see page 27). The user connected to the MX100 is indicated by User; the software program connected to the MX100 is indicated by Software.

Note

If the module configuration changes before connecting an MX100 that has been connected previously, a message, “Some detected modules do not match the current software configuration. Rebuild based on the current MX hardware setup?” appears. For procedures in this situation, see “Reconfiguring the System” in section 2.2 of the MX100 Standard Software User’s Manual (IM MX180-01E).
Setting the Acquisition Conditions of the Measured Data

Click Acquisition on the Monitor bar. Set the conditions on the Acquisition setup screen.

Setting the Monitor Interval and Record Interval

Sets the data measurement interval. The data monitor update interval and the alarm detection interval follow this setting. However, if the specified monitor interval is short, the data monitor update interval may be slower depending on the PC environment. If the monitor interval is set greater than or equal to 2 minutes, the Integration Monitor acquires data from the MX100 at the specified interval, but the measurement interval and alarm detection interval on the MX100 are to 1 minute. The input modules can be divided into three interval groups, and different monitor intervals can be specified for each. As shown below, you can assign an input module to any of the three groups by dragging the input module on to a group.

The record interval is the interval for saving the measured data to the hard disk or other storage medium. Different record intervals can also be specified for each group. Set the record interval by entering an integer multiple (up to 128) of the monitor interval for the group.

Note

The shortest interval that you can specify for the monitor interval is the longest measurement interval of the shortest measurement intervals of all the input modules assigned to the same interval group. For example, if an input module with the shortest measurement interval of 10 ms and an input module with 100 ms are assigned, 100 ms is the shortest interval that can be specified for the group.
• Monitor interval setup example
  As shown in the figure below, the waveform display area is shown for each monitor interval.

Setting the Record Start/Stop Condition
Set the start condition for saving the measured data (computed data also if computation channels are set to be recorded) to the hard disk (record start condition) and the stop condition. For a description of the record start/stop operation, see page 41.

- Immediately starts recording when the Record button on the Monitor screen is clicked or Record is chosen from the Acquisition menu.
- Starts recording at the specified date/time (year/month/day hours:minutes:seconds).
- Immediately stops recording when the Stop button on the Monitor screen is clicked or Stop is chosen from the Acquisition menu.
- Stops recording at the specified date/time (year/month/day hours:minutes:seconds).
- Stops recording after the specified time (hours:minutes:seconds) elapses after the recording is started.

* For a description of the record start/stop condition Math, see the MX100 Standard Software User’s Manual (IM MX180-01E).

Setting the Save Destination and Name of the Record File
Select the hard disk drive of your PC for the save destination. Do not specify a storage medium other than the hard disk or a network drive, as it may cause problems in terms of performance. By default, the save destination is the Data folder in the MX100 Standard folder where the MX100 Standard Software is installed.

The default file name is data. The extension is .mxd. You can also add record start date and time to the file name as follows.
- When both the date and time are added: data-0314-1316 (recording started at 13 hours 16 minutes on March 14)
- When only the date is added: data-20030314 (recording started at March 14, 2003)
- When only the time is added: data-1316 (started recording at 13 hours 16 minutes)

* For a description of the File division and Comment items, see the MX100 Standard Software User’s Manual (IM MX180-01E).
Setting Measurement Conditions

Click **Channel** on the Monitor bar to display the Channel setup screen. Click the **Meas. Channel** tab.

Set the items other than input mode and measurement range as necessary. For a description of setting alarms on measurement channels, see page 42. For a description of setting DO channels, see page 44. For a description of setting up computation channels, see page 46. For details about other channel settings, see the *MX100 Standard Software User’s Manual (IM MX180-01E)*.

* Cannot be used when Mode is set to RRJC

**Measurement channel tab**

- **Select to record, or clear to not record**
- **Channel number**
- **Select to monitor, or clear to not monitor**
- **Select the input mode**
- **Select the measurement range**
- **Minimum/Maximum value of span**
- **Check here to perform scaling**
- **Decimal point position of the scale**
- **Select the reference channel for differential input**
- **Check here to measure the differential input (difference with respect to the measured value of the reference channel)**
- **Maximum/Minimum values of the scale**
- **Select the reference channel for the remote RJC (valid only when the input mode is set to RRJC (TC))**
- **Unit (up to six characters, only when the Use check box of Scale is selected)**
- **Enter the tag comment (up to 30 characters)**
- **Enter the tag number (up to 15 characters)**
- **Set the time constant of the first-order lag filter (when the input mode is set to something other than DI)**
- **Set the burnout (valid only when the input mode is set to TC)**
- **Set the RJC (valid only when the input mode is set to TC)**

For instructions on these buttons, see the explanation under "Changing the Display Conditions" on page 37.
Set the initial balance for strain input channels (only when the input mode is set to STR)

Channel Numbers
See “Attachment Position and Channel Numbers of the Input/Output Module” on page 15.

Input Mode and Measurement Range
Select the input mode and range according to the input signal. The input types and measuring ranges vary depending on the module used.

- **VOLT (DC voltage)**
  Select the measurement range from 20 mV, 60 mV, 200 mV, 2 V, 6 V, 20 V, or 100 V.

- **TC (thermocouple)**
  Select the thermocouple type (referred to as Range in the setup) from Type-R, Type-S, Type-B, Type-K, Type-E, Type-J, Type-T, Type-N, Type-W, Type-L, Type-U, or KpvsAu7Fe.

- **RTD1 (resistance temperature detector, measurement current: 1 mA)**
  Select the RTD type (referred to as Range in the setup) from Pt100, JPt100, HQ Pt100 (high-resolution Pt100), HQ JPt100 (high-resolution JPt100), Ni100: SAMA (Ni100 1mA SAMA), Ni100: DIN (Ni100 DIN), Ni120, Pt50, Cu10:GE, Cu10:L&N, Cu10 :WEED, Cu10:BAILEY, or J263B.

- **RTD2 (resistance temperature detector, measurement current: 2 mA)**
  Select the RTD type (referred to as Range in the setup) from Pt100, JPt100, HQ Pt100 (high-resolution Pt100), HQ JPt100 (high-resolution JPt100), Pt50, Cu10:GE, Cu10:L&N, Cu10:WEED, Cu10:BAILEY, or J263B.

- **RTDEX (resistance temperature detector, measured current: 0.25 mA)**
  Select the RTD type (referred to as Range in the setup) from Pt500 (default setting) or Pt1000.

- **OHM (resistance)**
  Select a measurement range of 20 ohm (measured current: 1 mA), 200 ohm (measured current: 1 mA), or 2 kohm (measured current: 0.25 mA).

- **DI (digital input)**
  Select LEVEL (voltage input) or CONTACT (non-voltage contact input) for the measurement range to match the input.

- **STR (strain)**
  Select a measurement range of 2000 µSTR, 20000 µSTR (default value), or 200000 µSTR.

- **RRJC (TC) only when measuring temperature using TCs**
  Select a channel when referring to the temperature of a relay terminal (the temperature input of the relay terminal is specified at RRJC Ref. Ch.).
Setting the Measurement Span
Set the minimum and maximum values of the range that is actually measured within the measurable range.

Setting the Scale
Set this item when linearly scaling the measured values. Set the scale by entering the maximum and minimum values corresponding to the maximum and minimum values of the measurement span and selecting the decimal point position of the scaled value. You can also assign a unit (up to 6 characters) to the scaled value.

Setting the Reference Channel for Differential Input
Set this item when making the difference between the measured value of the channel and the measured value of the reference channel the measured value. Set the reference channel to a measurement channel with the same measurement range and whose Monitor check box is selected.

Setting the Remote RJC Reference Channel (Valid Only When the Input Mode Is Set to RRJC (TC))
Set the reference channel for the remote RJC. The thermocouple type of the reference channel must be the same.

Setting the Time Constant of the First-Order Lag Filter (Valid Only When the Input Mode Is Set to Something Other Than DI)
A first-order lag filter is available. Set the time constant (time until 63.2% of the output value is reached) for the case when the measurement interval is set to 1 s.

Setting the Burnout (Valid Only When the Input Mode Is Set to TC)
Select the burnout detection behavior from the following.
* Up: Fix the measured value to +Over (over the upper limit of the measurement range) when a burnout is detected.
* Down: Fix the measured value to -Over (over the lower limit of the measurement range) when a burnout is detected.
* Off: Burnouts are not detected.

Setting the RJC (Valid Only When the Input Mode Is Set to TC)
Select whether to use the internal reference junction compensation function of the input module or an external reference junction compensation function. When using the external reference junction compensation function, set an appropriate reference junction compensation voltage in the range of -20000 µV to 20000 µV.

Initial Balancing of Strain Input Channels (Initial Unbalance Value Adjustment)
When configuring a bridge circuit with a strain gauge, the bridge circuit will not necessarily be balanced even if the strain of the circuit under test is zero due to the slight deviation in resistance of the strain gauge, and the measured value may not be zero (the value in such cases is called the initial unbalanced value).
Therefore, when taking measurements you must first balance the bridge and, if the strain is zero, obtain a measured value of zero. This is called initial balancing. (setting the initial unbalanced value to zero).
Monitoring the Measured Data and Setting the Display

Click **Monitor** on the Monitor bar. You can monitor the measured data on the Monitor screen that opens.

Monitoring the Data Using Trend Waveforms

Monitoring the Data Using Numeric Values
Monitoring the Data Using Trend Waveforms and Numeric Values

Updating the Display Using the Display Menu and the Information Displayed on the Status Bar

Switch to waveform, numeric, or waveform and numeric display
Switch the display group
Change the display area
When paused, you can drag to change the display area of the digital and waveform displays.

Numeric display screen  Waveform display screen
Changing the Display Conditions

Click **Display** on the Monitor bar. You can change the display conditions on the Display setup screen that opens. The automatic channel assignment function is convenient for assigning all the channels that were specified to be monitored in “Setting the Measurement Conditions” on page 32 to the display groups.

### Display Groups and Group Names

The Monitor screen displays waveforms or numeric values by dividing the channels into groups. The measured/computed values can be divided into up to 10 groups. Up to 32 channels can be registered to a single group.

The channels that can be registered are those whose Monitor check boxes are selected on the Channel setup screen. When you click a channel selection button on the Display setup screen, the channel numbers of the channels that can be registered are displayed (see the figure below). You can also select the channel by tag number or tag comment by switching the tab.

You can enter a group name using up to 30 characters. By default, group names Group 1 to Group 10 are assigned.
Selecting the Display Zone of the Trend Waveform

You can select from the following. Taking the bottom and top edges of the waveform display area to be 0% and 100%, respectively, set the waveform display position by specifying the minimum value (0 to 99%) and the maximum value (1 to 100%).

- **User zone**
  Displays each waveform at the position specified by Zone on the Display setup screen. A single Y-axis scale of the active waveform can be displayed.

  ![User zone diagram]

<table>
<thead>
<tr>
<th>Zone</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>User</td>
<td>99</td>
<td>100</td>
</tr>
</tbody>
</table>

- **Edit zone**
  Like the user zone, each waveform is displayed at the position specified by Zone on the Display setup screen. However, you can change the zone on the Monitor screen. A single Y-axis scale of the active waveform can be displayed.

  ![Edit zone diagram]

  Drag the knob to change the minimum/maximum value of the zone separately.

  Drag the bar to change the zone position without changing the zone width.

- **Full zone**
  Displays all the waveforms over the full zone of the waveform display area regardless of the Zone settings on the Display setup screen. A single Y-axis scale of the active waveform can be displayed.

  ![Full zone diagram]

- **Slide zone**
  Displays the waveforms by slightly offsetting the display position of each waveform vertically regardless of the Zone settings on the Display setup screen. A single Y-axis scale of the active waveform can be displayed.

  ![Slide zone diagram]
• Auto zone
Displays the trend waveforms by dividing the waveform display area evenly according to the number of displayed waveforms regardless of the Zone settings on the Display setup screen.

Select auto zone

Divide evenly automatically

• Multi-axes zone
All the Y-axis scales of the displayed waveforms are aligned horizontally. To hide a Y-axis scale, clear the Y-Axis check box on the Display setup screen. The display zone is set to the position specified by Zone on the Display setup screen.

Select multi-axes zone

Indicates the active Y-axis bar

Click the bar to move the active Y-axis to the left end

Turn OFF the Y-axis display of Ch00002

The Y-axis of Ch00002 is not displayed.

Trip Point
You can display a trip line to indicate a particular value of interest (trip point) in the waveform display area. Two trip points (trip 1 is red, trip 2 is blue) can be set on each waveform. The trip line of the waveform corresponding to the left-most Y-axis is shown in the waveform display area.

Turn ON the trip line display

Trip 1 value

Trip 2 value

Clip OFF

Clip ON

Clipping of Trend Waveforms
By default (clip OFF), the waveform is not displayed when the measured/computed value exceeds the minimum/maximum value of the scale (see the lower left figure). When clip is turned ON, values that are smaller than the minimum value of the scale are displayed as the minimum value and the values that are larger than the maximum value of the scale are displayed as the maximum value.
Displaying Marks
You can display marks in the trend waveform area (see the figure below). You can enter a text to be attached to the mark ("Mark" by default) using up to 15 characters. Click the Mark button or choose Mark Configuration from the Action menu. You can enter the text in the dialog box that opens.

Mark setup dialog box

Pausing the Updating of the Monitor Display and Reading Measured Values Using Cursors

Pausing and Resuming the Updating of the Monitor Display
Click the Pause button on the Monitor screen or choose Pause from the Acquisition menu to stop the updating of the monitor display. When paused, the word "Pause" under the button toggles between red and black. To resume the updating, click the Pause button on the Monitor screen or choose Pause release from the Acquisition menu.

Note
Recording continues even when the updating of the monitor display is stopped.

Reading Measured Values Using Cursors
You can read measured values (computed values) using cursors when the updating of the monitor display is paused. Click the position where you wish to read the value in the waveform display area. If you wish to read another point simultaneously, drag the cursor. Cursor A appears at the position where you first clicked; Cursor B appears at the position where you released the mouse button. The measurement point is indicated by a yellow circle at the cross point of the cursor and waveform.
To clear the cursors, choose **Hide Cursor** from the **View** menu.

**Recording the Measured Data**

For details on setting of the record start condition and setting the save destination and file name of the record file, see page 30.

**Record Start Operation**

Click the **Record** button on the Monitor screen, or choose **Record** from the **Acquisition** menu.

When recording starts, the display changes as shown in the figure below. To divide the file during recording, click the **Manual Save** button or choose **Manual Save** from the **Acquisition** menu.

If Start Condition described is not set to On Record, recording does not start until the specified condition is met. While the Start Condition is not met, the word “Waiting” appears under the Record button (see figure below).

**Record Stop Operation**

To stop recording when Stop Condition described is set to Manual or before the Stop Condition is met, click the **Stop** button or choose **Stop** from the **Acquisition** menu. When the message “Stop Record?” appears, click **OK**.
Setting Alarms

Click Channel on the Monitor bar to display the Channel setup screen. Enter settings in the Meas. Channel or Math Channel tab.

Scroll to the right to display alarms 1 to 4

Hysteresis of alarm 3
Alarm value of alarm 3
Alarm 3 type
Hysteresis of alarm 2
Alarm value of alarm 2
Alarm 2 type
Hysteresis of alarm 1
Alarm value of alarm 1
Alarm 1 type

For measurement channels

Displaying Alarms on the Trend Waveform Display

The interval while an alarm is occurring is indicated by a bar at the bottom section of the waveform display area (see the figure below).

Alarm display area
Show/Hide alarm
Switch the active channel
Period of alarm occurrence

Alarm Indication on the Numerical Display

Four alarm signals are displayed above the measured value (see the figure below). The changes in the color of these alarm signals indicate the alarm status.

Red: Alarm occurrence
Green: Alarm OFF
Black: Alarm not set
Alarm Type
The following six alarm types are available.
When not using differential input on measurement channels, select OFF, High, or Low. When using differential input, select OFF, dHigh, or dLow. On computation channels, select OFF, High, Low, rHigh, or rLow.

- Upper limit alarm (High)
  Generates an alarm when the measured or computed value is greater than or equal to the alarm value.

- Lower limit alarm (Low)
  Generates an alarm when the measured or computed value is less than or equal to the alarm value.

- Differential upper limit alarm (dHigh)
  Generates an alarm when differential input values (difference between the measured value of a channel and that of the reference channel) are greater than or equal to the alarm value.

- Differential lower limit alarm (dLow)
  Generates an alarm when differential input values (difference between the measured value of a channel and that of the reference channel) are less than or equal to the alarm value.

- Upper limit on rate-of-change alarm (rHigh) ← setting only on computation channels
  Generates an alarm if the amount of change in the computed value in the rising direction exceeds the alarm value within the rate-of-change detection interval.

- Lower limit on rate-of-change alarm (rLow) ← setting only on computation channels
  Generates an alarm if the amount of change in the computed value in the falling direction exceeds the alarm value within the rate-of-change detection interval.

The rate-of-change detection interval is the measurement interval × measurement count. Select that measurement count (1 to 15) in the Rate-of-change alarm interval setting in the Meas. Channel settings.

Note
Do not close the connection between the MX100 and PC software. Computation channel alarms will not occur because the computation function does not work when using only the MX100.
Operations of the MX100 Standard Software

Alarm Hysteresis
You can set a width (hysteresis) to the values used to activate and release alarms. Alarm hysteresis prevents frequent activation and release of alarms when the measured/computed value is unstable around the alarm value.

Digital Output
Click Channel on the Monitor bar to display the Channel setup screen. Set the output of the digital output module in the DO Channel tab.

Selecting the Action for the Digital Output
The digital output can be enabled for the following causes.

- **Alarm output**
  Outputs a signal when an alarm occurs according to the alarm settings.

- **Manual DO**
  When the manual DO button on the Monitor screen is clicked, all the DO channels assigned to the button number output relay contact signals collectively.

- **FAIL output**
  Outputs a relay contact signal when a error occurs in the main module CPU.

- **Error output**
  Outputs a relay contact signal when any of the following events occur.
  - A data output request timeout (60 s) occurs while recording data.
  - A module error occurs.
Energized/De-energized Operation of Output Relays
You can select whether the output relay is energized or de-energized when an output event (such as an alarm) occurs. If de-energized is selected, the output relay behaves in the same fashion as when an output event occurs if the power is shut down. The default setting is Energized. The FAIL output is fixed to De-energized.

Hold/Non-Hold of Output Relays
Select the behavior of the output relay when an output event is released (recovers to a normal condition). The default setting is Non-hold
• Turn OFF the output relay with the release of the output event (non-hold).
• Hold the output relay at ON until the Relay ACK button (see below) is clicked.

Note
If connection with the PC is dropped, the state at the point at which the DO output was dropped is retained. However, DO output to which measurement channel alarm detection is assigned functions normally even if the connection with the PC is dropped.
Operations of the MX100 Standard Software

Setting the Computation

You can enter computing equations using operators, constants, and functions. The computed results can be displayed and recorded (saved). Computation allows you to determine the average/maximum/minimum of a specified channel on a specified date/time or output events (start/stop record, reset time, etc.) under specified conditions. For details on computations including available operators, constants, and functions, see the MX100 Standard Software User’s Manual (IM MX180-01E).

Set computations using Math Channel on the Channel setup screen in the figure below. Set the monitor interval and record interval for computed data on the Acquisition setup screen.

Saving/Loading and Printing of Setup Data (Project)

Saving Setup Data (Project)

From the File menu, choose Save or Save As to save the setup data. The default save destination is the folder depends on the system that is running. The extension is .mxp. The default file name is NewProject.mxp.
Loading Setup Data (Project)
From the File menu, choose Open.

Printing Setup Data
From the File menu, choose Print. Settings such as the network information of the MX100, information about the attached modules, acquisition conditions, and measurement conditions are printed in tables.
Displaying Recorded Measured Data, Reading Values Using Cursors, and Statistical Computation over an Area

You can display measured or computed data that has been recorded.

1. Choose Programs > MX100 Standard > MX100 Viewer to start the Viewer. You can also choose Launch Historical Viewer from the File menu or click the button on the Integration Monitor.

2. From the File menu, choose Open.

You can also click the button on the toolbar.

The Open dialog box opens.

3. Select the file you wish to load and click Open.

The waveform display window opens.

When a file recorded using the Integration Monitor is opened, a dialog box for confirming whether to carry out synchronization (see the note below) opens. Click Yes or No.

Note

The data recorded using the Integration Monitor has time stamps attached by the MX100 (see section 1.2, “Main Module Functions” in the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E)). When synchronization is carried out, the time is corrected to the time on the PC, and the data is saved using the corrected time. The name of the created file remains the same but with a different extension .mxs. The file with .mxd extension before synchronization is not deleted.
Changing the Display on the Waveform Display Window

You can change the display using operations similar to the waveform display area of the Monitor screen of the Integration Monitor.

- Switch the display group
- Scale
- Turn ON/OFF the channel
- Change the grid density
- Channel number and measurement unit
- Change the background darkness
- Zoom in or out of the time axis
- Switch the display zone
- Switch the active waveform
- Alarm display ON/OFF
- Clip display ON/OFF
- Zone display area ON/OFF
- Move the cursor to the point where the alarm changed
- Switch the grid display

Changing the Display Using the Toolbar

See the explanation in the figure below.

- Channel number display
- Show the General Display Settings window
- Tag number display
- Tag comment display
- Switching between Absolute and Relative time
- Show the waveform display window
- Alarm/Mark List
- Show the numeric display window
- Show the window for displaying cursor values
- Show the window for displaying statistical computation over an area
- Adding marks
- Move cursor A to the left mark
- Move cursor A to the right mark
- Move cursor B to the left mark
- Move cursor B to the right mark
- Channel number display
- Tag number display
- Tag comment display
- Switching between Absolute and Relative time
- Show the waveform display window
- Alarm/Mark List
- Show the numeric display window
- Show the window for displaying cursor values
- Show the window for displaying statistical computation over an area

Changing the Display Using the Menu

Choose appropriate commands from the Edit, View, and Window menus to change the display.

- Show the computation result display window
- Change the data file display
- Switch between channel number, tag number, and tag comment
- Switch between absolute and relative time*
- Turn ON/OFF the toolbar
- Turn ON/OFF the status bar
- * Displays also the Format item during numeric display

Operations of the MX100 Standard Software
Changing the Display Using the Display Setup Window

See the explanation in the figure below. Change the display settings and click OK. Set the display for each display group. The settings are similar to the Display screen on the Integration Monitor.

Numeric Display

You can also show the numeric display window (see the figure below). With the waveform display window open, click the button on the toolbar or choose Sheet from the Window menu. When groups with different monitor intervals are present, the screen is divided accordingly.
Reading Values Using Cursors

Click the tab of the group on which you wish to read values using cursors on the waveform display window. Click the position where the measured (computed) data is to be read in the waveform display area on the waveform display window. If you wish to read another point simultaneously, drag the cursor. Cursor A appears at the position where you first clicked; Cursor B appears at the position where you released the mouse button. The measurement point is indicated by a yellow circle at the cross point of the waveform and cursor. You can move the waveform that is displayed in the waveform display area using the scroll buttons or scroll bar.

You can show a window displaying the cursor measurement values (see the figure below). From the Window menu, choose Control.

Statistical Computation over an Area of Measured Data

Show the cursors in the same fashion as when reading the values using cursors. Cursor A is the start position of computation area; Cursor B is the end position of the computation area.

From the Window menu, choose Statistics to open the Statistics window shown in the figure below.
Alarm/Mark List Display
Displays a detailed list of alarms and marks.
From the Window menu, choose Alarm/Mark List.
You can also click the button on the toolbar.

- **Alarm List**

  Sorted according to the clicked item

  Currently sorted to the item indicated by this mark

<table>
<thead>
<tr>
<th>Item</th>
<th>Type</th>
<th>Alarm ON</th>
<th>Alarm OFF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item 1</td>
<td>High</td>
<td>20000001-04:41:21-00</td>
<td>20000002-04:41:37-00</td>
</tr>
<tr>
<td>Item 2</td>
<td>Low</td>
<td>20000003-04:42:27-00</td>
<td>20000004-04:42:39-00</td>
</tr>
</tbody>
</table>

- **Mark List**

  Sorted according to the clicked item

  Currently sorted to the item indicated by this mark

<table>
<thead>
<tr>
<th>Item</th>
<th>Mark</th>
<th>Group</th>
<th>Name</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item 1</td>
<td>Mark</td>
<td>Group</td>
<td>Name</td>
<td>Time</td>
</tr>
<tr>
<td>Item 2</td>
<td>Mark</td>
<td>Group</td>
<td>Name</td>
<td>Time</td>
</tr>
</tbody>
</table>
Printing the Displayed Data

To print waveforms, open the waveform display window; to print numeric values, open the numeric display window. If multiple windows are open, click the window that you wish to print. To print values read by the cursors or statistical computation over an area, open those windows also.

After selecting the object to be printed, choose Print Setting from the File menu. In the Print Setting dialog box, set Range, Color, and Print Groups, and then click OK. Then, choose Print from the File menu to execute the printing. When printing numeric values, you only need to set the range.

Converting the Format of the Recorded Measured Data

Conversion can be made into the following formats.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII</td>
<td>Text data with each data point separated by a comma. The extension is .txt.</td>
</tr>
<tr>
<td>Excel</td>
<td>Data that can be opened using Microsoft’s spreadsheet application Excel version 8.0 (Excel 97) or later. The extension is .xls.</td>
</tr>
<tr>
<td>Lotus</td>
<td>Data that can be opened using IBM’s Lotus 1-2-3 spreadsheet application version 2.0 or later. The extension is .wj2.</td>
</tr>
</tbody>
</table>

From the Convert menu, choose To ASCII, To Excel, or To Lotus. Then, convert the data using the dialog box that opens (see the figure below). There is a limitation in the number of data points that can be handled in the Excel conversion or Lotus conversion. Before executing the conversion, set the channels/groups to be converted, the conversion range, and the step so that the number of data points is appropriate.